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Print the quality,
data-rich labels your
business requires...
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Pocket LABELVIEW™

Pocket LABELVIEW™ is the Pocket PC version of the popular
LABELVIEW™ |abel design and printing software. It is the most
powerful, flexible, and easy-to-use portable label printing solution
available today.

Pocket LABELVIEW allows you to take labels created in
LABELVIEW™ Gold version 7.02 or higher, download them to
your Windows® CE/Pocket PC device, and print them using a
direct or network/wireless connection. Pocket LABELVIEW
supports standard types of label content, including text, bar
codes, graphics and more. Pocket LABELVIEW also allows you
to access data from variable data sources including database,
serialization and prompted fields for text and bar codes.

Portable Label Printing Made Easy

Today's businesses demand easy-to-use, mobile solutions. With
recent advances in technology, processes that were once limited
to PCs on the shop floor are now possible from anywhere in the
world using a device not much larger than a cell phone. One of
these key processes, critical to companies in many industries, is
bar code label printing.

Mobile solutions for label printing do exist on the market today,
but they are very limited as to the type of data that can be used
on a label design. For example, some packages do not support
input from databases or commonly used functions like
automatically calculating an expiration date. So although these
solutions may work for printing simple, static label designs, they
do not offer the level of functionality that is typically needed for
companies in manufacturing, warehousing, and distribution who
need to print more advanced bar code labels.

Enter Teklynx' Pocket LABELVIEW bar code label printing
software for Windows CE/Pocket PC devices. Pocket
LABELVIEW goes above and beyond the rest by allowing you to
use a Windows CE/Pocket PC device to print the quality, data
rich labels your business requires, without sacrificing the features
you've come to rely on when printing labels from your PC.



Pocket LABELVIEW
gives you a variety of
options for using the
latest low-cost Windows
CE/Pocket PC devices

Pocket LABELVIEW
allows you to access
data from variable data
sources
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Pocket LABELVIEW Overview

How it Works

Design your labels in the LABELVIEW label design software and
then simply transfer the label design files to the Windows
CE/Pocket PC device. From there you can print wirelessly or via
a wired connection to any thermal or thermal transfer printer
natively supported by LABELVIEW printer drivers.

Device Support

Pocket LABELVIEW supports many standard CE-based portable
terminals, giving you a variety of options for using the latest low-
cost devices. Windows CE/Pocket PC devices offer extended
networking and wireless capabilities, and are smaller and more
portable than laptops or bulky printing terminals. In addition,
using Pocket LABELVIEW with Windows CE/Pocket PC devices
allows you to set up and edit your labels using a graphical
display, making it an easy transition for those who are used to
printing labels from their PC.

Pocket LABELVIEW supports the Pocket PC and Pocket PC
2000 platforms, and the StrongARM, MIPS, SH3 and X86
processors. The following are examples of Windows CE/Pocket
PC devices that use a supported processor type:

Casio Cassiopeia E200 HHP Dolphin 7400

Casio E115 HHP Dolphin 7450
Casio E125 Intermec 5020
Casio EM500 Intermec P70

Casio EG800 Intermec 5023
Casio IT70 NEC MobilPro P300
Casio IT700 Symbol 2800
Compaq Aero1550 Symbol PPT2700
Compagq iPAQ Symbol PPT8100

HHP Dolphin 7300 Toshiba e740

Support for Variable Data

The following types of variable data input are supported by
Pocket LABELVIEW:

o "When Printed" fields, allowing you to prompt the user
for the field value at print time

e Date and Time fields

e Formula fields to calculate expiration dates, box
counts, etc.

o Database (dBase) download and support

e Advanced serialization (remembers last value of an
incrementing field)



The following table summarizes the variable data features supported by Pocket

LABELVIEW.

Feature
When Printed Fields

Description

Prompt the user for the
field value at print time.

Benefit
Useful for entering
information that changes
from label to label, such as
the customer and
purchase order data on a
shipping label.

Date and Time Fields

Date and Time fields are
retrieved from the device's
system clock when the
label is printed.

Allows easy time and date
stamping. For example,
you can print "Best Used
By" labels or print a
date/time stamp on labels
to help track employee
shift changes.

Formula Fields

Use mathematical
calculations to manipulate
and concatenate fields.

Useful for common label
elements such as
expiration dates and box
counts (Box 1 of 10, Box 2
of 10, etc.)

Database Fields

Access data from dBase
databases.

Provides a greater level of
accuracy and efficiency for
populating fields with data.
Local storage of database
files offers mobile
convenience.

Advanced Serialization

A serial file is used to track
the number of labels
printed so that for the next
print job, counting can
continue with the next
value in the series. Serial
file values can be
updated/reset using
Pocket LABELVIEW.

Print sequential numbers
such as serial numbers,
shelf numbers,
coupon/ticket numbers,
etc.
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Label Download Options

Pocket LABELVIEW offers two options for downloading labels to
the Pocket PC—a standard download procedure and a more
advanced wireless network download procedure. For both
download options, all files associated with the label design (e.g.,
serial files, database files, etc.) are automatically downloaded
along with the label files in the download process.

Standard Download

The standard download procedure is used for most typical direct
label printing applications. With this method you simply download
the labels via LABELVIEW with your Pocket PC device in its
cradle, and then LABELVIEW uses ActiveSync to transfer the
files to your Pocket PC. For more detailed information on the
steps involved with the standard download, see Step 2 of the
Pocket LABELVIEW Label Printing Example section.

Wireless Network Download

Pocket LABELVIEW allows downloading of label design files over
a wireless network using standard Windows protocols. This is
especially useful in situations where multiple devices are used for
the same application and need to have the same label design for
printing. The network download method simplifies adding a new
device to the fleet and ensures that everyone using mobile
devices has access to the latest label design formats.

To use this feature simply create and share a folder on a server
where all of the label designs are stored, note the path to the
folder, and create a user ID and password for access to this
shared folder. Next, set up Pocket LABELVIEW to take
advantage of this shared folder.

Printing Options

Pocket LABELVIEW offers a variety of printing options for printing
labels to a printer on your desk or to a printer located across the
globe. Pocket LABELVIEW offers the widest printer support in the
industry, allowing you to print to over 600 native LABELVIEW
drivers for thermal/thermal transfer printers.

Note: When selecting a printer in the LABELVIEW software, you
must select a native printer driver (developed specifically for use
with LABELVIEW), designated by a (V) appearing after the printer
name.
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Direct Printing

Print from the Windows CE/Pocket PC device directly to a local
printer.

Network/Wireless Printing

Pocket LABELVIEW takes full advantage of the wireless
capabilities of Windows CE and the Pocket PC. If you are running
Pocket LABELVIEW on a wireless enabled Pocket PC, all you
need is a wireless access point and you can connect the Pocket
PC to the wired network. Once that connection is made you will
be able to print to any TCP/IP addressable printer on the network.

The wireless standard supported today on the Pocket PC is the
WiFi standard, or 802.11b. This standard is widely accepted and
relatively inexpensive to implement.

In order to set up a wireless network printer to print your labels,
you must first add the TCP/IP ports in Pocket LABELVIEW. This
is easily accomplished using Pocket LABELVIEW's Configuration
TCPI/IP Ports settings.
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Figure 1: TCP/IP Ports settings

Printing to a Queue

In addition to communicating in real-time via a wireless network
connection, Pocket LABELVIEW can also be used in a batch
mode.

There are many situations where it may be useful and even
advantageous to take a mobile device out into the field to print
labels in a batch mode and then print them all at a later time. An
example might be the QA department of a manufacturing
company where reworked parts need to be relabeled. The QA
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technician could scan the original label of all the reworked parts
and then print the whole batch of labels before re-labeling the
entire lot.

To send print jobs to a queue, simply select the appropriate
output port and click the Queue print jobs check box. Then click
Print to save your print jobs to Pocket LABELVIEW's Data folder.
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Figure 2: Queue print jobs

Automatic Printing Using Command Files

A command file is a simple instruction file that can be used to
print labels automatically. You specify the name of a folder to be
monitored, and the system checks for the existence of a
command file (.cmd file) based on the time interval specified.
When a command file is detected in the folder, the system
processes the command files and prints the labels. All command
files executed in the monitored folder are deleted after printing.

A command file contains commands that identify the name of the
label, the printer to use, and the label quantity. Variable data can
be provided in the command file, or it may be provided in a
separate data file. A command file is an ASCII text file that can be
created with any text editor. Command files have a .cmd file
extension. A sample Pocket LABELVIEW command file might
look like this:

LABELNAME=Shipping.lbl
PRINTER="192.168.1.102,9100"
TEXT]I="XXXXXXXXXX"

TEXT2="yyyyyyyyyy"
BARCODE1="12345678"
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Command files can also be used to pass information generated
by other systems and possibly other computers, including
mainframes or mini-computers. For example, an invoicing
program could pass information into a command file, which would
in turn print a label.

To set up a command file in Pocket LABELVIEW, you first need
to specify the Folder to Monitor (the folder that will contain the
command files). Set other command file options as desired,
including the time interval at which the folder is monitored for
changes, and whether the command files should be processed
based on when the files are created (Date Time setting) or
processed in alphabetical order (File Name setting).
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Figure 3: Command File Setup

For more information on using command files to print labels
automatically from Pocket LABELVIEW, see the Pocket
LABELVIEW Quick Start Guide or Help.



Pocket LABELVIEW White Paper

Pocket LABELVIEW Label Printing
Example

Step 1 - Install and Activate Pocket LABELVIEW

1.

Open the Microsoft® ActiveSync® synchronization
software (included with all Microsoft® Windows powered
Pocket PCs). ActiveSync must be active on your computer
in order to successfully install Pocket LABELVIEW.

In LABELVIEW Gold 7.02 or higher, select Configuration
from the Options menu and click the PRINTPAD / Pocket
LABELVIEW tab.

Under the Platform options, click Pocket LABELVIEW
and then select your Windows CE/Pocket PC device from
the Model list. If your exact model is not listed, try
selecting the generic processor type (e.g., StrongARM,
MIPS, or SH3) that applies to your model.

Click Activate to access the Pocket LABELVIEW
Activation Manager.

Using the Activation Manager options, install the Pocket
LABELVIEW application on your Windows CE/Pocket PC
device and then activate it.

Step 2 — Design the Label in LABELVIEW and
Download it to the Windows CE/Pocket PC Device

1.

Using LABELVIEW's intuitive drag and drop interface,
design a label containing different types of fields, like text,
bar codes, or graphics.
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Figure 4: LABELVIEW label design interface
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Note: For information on designing labels, see the LABELVIEW
Quick Start Guide or Help.

2. Set the label to print to a natively supported printer. You

must select a native printer driver (developed specifically
for use with LABELVIEW), designated by a (V) appearing
after the printer name.

Save the label.

On the File menu, click Download Label to Pocket
LABELVIEW. The Download Label dialog box appears.

Dawnload Label to Packet LABELVIEW K

CALWWINZONLBLY Selected Label:

dbasze.lbl Select Dir... shipping.Ibl
invertory. lbl
price. lbl
shipping. bl Add->
Add All->>
<-Remove
<<-Remove Al

Close

Dovanload

Figure 5: Download labels to Pocket LABELVIEW

Click Select Dir and specify the directory where the label
is saved.

Select the label to be downloaded and click Add to move
it to the Selected Labels box.

Once all desired labels appear in the Selected Labels
box, click Download.

Specify the directory in which you want to store the label
and click OK.

A Data subfolder will be created within the specified
directory. The selected label and all associated files will
be optimized for transfer and placed in this Data
subfolder. The folder will act as a temporary storage bin
for your label formats as they are automatically
downloaded to your Windows CE/Pocket PC device.

10
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Step 3 (Optional) — Update Serial File Value

Note: For purposes of this example, we will assume we have a
label that contains a serial number field coming from a serial (.srl)

file.

To edit a serial file so that it starts at a different number:

1. On the Pocket LABELVIEW Main Menu, click Update
Serial #. The serial file editing screen appears.

£33 |Pocket LABELVIEW ot 428 (D

SCC14 st
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Figure 6: Update serial number

2. Highlight the serial file name and click Load.
The current serial value will appear in the edit box.

3. To update the serial value, type the new value in the edit
box and click the Save button.

Step 4 — Print Labels

1. On the Pocket LABELVIEW Main Menu, click Print
Labels. The Pocket LABELVIEW print settings appear.

11
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Figure 7: Print settings

2. Select the label to print.

If the label contains variable data fields, the associated
prompts and field values will appear.

3. To print labels with variable data (When Printed or
database fields), use the Windows CE/Pocket PC stylus to
double-tap the row containing the field in which you want
to input or edit data.

4. Use the print settings to set up your print job and click
Print to print your labels.

Summary

Pocket LABELVIEW bar code label printing software for Windows
CE/Pocket PC devices allows you to take advantage of the small
size and portability of CE-based portable terminals. With Pocket
LABELVIEW you can print the quality, data-rich labels your
business requires, without sacrificing the features you've come to
rely on when printing labels from your PC.

Pocket LABELVIEW does this by allowing you to access data
from variable data sources including database, serialization and
prompted fields for text and bar codes. It also offers the widest
range of thermal/thermal transfer printer support and supports
wireless and network printing.

Finally, rest assured knowing that Pocket LABELVIEW works with
LABELVIEW software — a proven bar code label design solution
available in 18 languages and backed by worldwide service and
support.
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For More Information

For more information on Pocket LABELVIEW and its functionality,
visit the Teklynx web site at http://www.teklynx.com/.

Copyright 2003 Braton Groupe sarl. All rights reserved.
This white paper is for informational purposes only. Product specifications are likely to change.

TEKLYNX and LABELVIEW are trademarks or registered trademarks of Braton Groupe sarl or its affiliated companies. Other
product or company names mentioned herein may be the trademarks of their respective owners.
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